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1 Preface

The provided KRASTA model ,telescopic boom* is a virtual model of a trailer crane. The only purpose
of this model is to demonstrate selected capabilities of KRASTA. The model itself is highly simplified
and essential loads and structural details are missing. The model is not meant as an example on how
to map a real structure on a KRASTA model.

This example was created with KRASTA 9.7. Older KRASTA versions may lack features mentioned in
this document.

2 KRASTA basics

2.1 Screen layout
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2.2 Units
Units can be changed at any time even when object dialogs are open. Main menu:

Option > Units

2.3 Languages

The language can be changed at any time for the user interface (dialogs, menus etc.), result output and help
file. Main menu:

Option > Languages
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2.4  Sizes of text and graphic elements, colors
The graphic display can be customized. Main menu:

Display > Screen
Display > Colors

2.5 Changing the model view

You may rotate the display of the graph|cs window with the dlsplay buttons in the second button row.
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From KRASTA 9.6 on dynamic rotate and zoom is available, please check the manual for the keyword
“Orbit”.

2.6 Selecting nodes and beams

Activate the according selection mode for beams or nodes. In KRASTA you may select, unselect or invert
beams and nodes by clicking in the graphic window. The corresponding buttons to change the selection
mode can be found in the first button row.

| _| e ;| d g [Ausleger J |wuuonn -l
Miriimal hd

g DK RO e e N s S N Y S =l e .
B aum minimisrern |

3 The example model
3.1 Opening the model

If the model is still in a zip file choose from the main menu: File > Unpack and open. Navigate to the
zip file and press the open button. KRASTA unpacks the zip file and opens the model files.

If you have already unpacked the zip file choose from the main menu: File > Open.

3.2 Exploring the Geometry

Change the model view (see 2.5) to get an impression of the global structure. You may switch on and
off additional information for the graphics window, e.g. cross sections, beam and node names, support
conditions and joints. Click on the button "display settings" (eye icon) and activate the desired options.
“Display settings” may be saved and recalled for a faster workflow in the left selection box. Some
“display settings” have already been saved during the modeling of the example.
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Display settings in the example model:
Minimal — Standard display setting with nodes and beams
Arrow — Arrows from beam start to beam end are drawn
Arrow_Aux vect — Arrows and auxiliary vectors are drawn
Cross sections — Cross sections are drawn on the beams
Joints — Joints are drawn
Support Conditio — node support conditions are drawn
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3.3 Masses

Masses are entered as “basic mass cases” where you can put node/beam masses on nodes/beams or
apply a mass factor to the structural mass of (parts of) the structure. The masses are usually taken
from parts lists or are estimated from earlier projects. To see the mass distribution and the sum drag
the mass case from the tree and drop it on the graphics window. To switch off the mass display select
“minimal” from the saved display settings.
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Basic mass cases are combined into combination mass cases which depend on the required
combinations for load cases.

3.4 Loads

Various load types are available for basic load cases. Most common are acceleration load cases
where you accelerate (gravity, drive or slewing acceleration) mass cases. You can also apply node
and beam loads as well as other loads. See image below for an overview of load types.
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Drag the load cases from the tree and drop them to the graphics display to visually check the loads.
To switch off the loads display select “minimal” from the saved display settings.
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Basic load cases can be combined to combination load cases.

Logic load cases apply a permutation logic to a set of load cases, such as “exactly one”, “one or

none”, “all possible combinations” or “all”.
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3.5 Subsystems

The model is divided into different subsystems. Subsystems are individual subsets of beams and
nodes which can be moved relative to each other by using kinematics or switching contacts.

To create a subsystem mark all nodes which should belong to the new subsystem. The correct control
hierarchy in the “Subsystems”-object tree is automatically created, if the subsystem is split in the
relevant order which depends on the telescopic crane movement.
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For separating select “Subsystem” in the Main Menu and choose “Split off Marked Nodes as New
Subsystem”.

Subsystem > Split off Marked Nodes as New Subsystem
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In the window “Subsystem” name the new subsystem for better navigation and orientation. The Parent
System is automatically filled with the previous subsystem.
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To see the subsystem in different colors choose “Sequential” in the right selection box in the second
button row.
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After “Split off Marked Nodes as New Subsystem” automatically contacts and connections are formed.
They can be edited in the object tree. It is recommended to hame them immediately after separating

and according to their purpose.

The model consists of 6 different subsystems. To get an idea on the different subsystems open the
display settings dialog and choose the “Coord./Subs.” register. To space the subsystems select a
“Subsystem Factor” smaller than 1 (0.9 will do in most cases) and apply. To take a look at the contacts

and the connections take a check mark on “Connections” and apply.
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3.6 Orientations

3.6.1 General

Page 9 of 22

“Orientations” are the geometric definition of the working position. There are three types of

orientations: “Basic Orientation”,

Relative Orientation” and “Orientation Modification”.

In the “Basic Orientation” a set of orientation information is stored. When you create a basic
orientation the current state of the model is recorded as a kind of snapshot. The following information

is stored:

1) Definition and values of individual subsystem orientations
2) As aresult of 1) the subsystem hierarchy in the object tree

3) Connections used in contacts
Eventually this information needs to be updated if the model is modified.

In the basic orientation dialog an equal sign at the beginning of each entry indicates that the entry
definition is valid for the current model state.

%’ Basic Orientation (set Position / Linking)

= 22

Mame

Comment

|B agic

Infarmation

e

Read actual Orientation Data
Orientation D ata
= [Slewing [Undercariage]
= Contact [UC - Slew.Ring] connect [Undercariage.to Slewing Ring) to [Slewing Ring.to U
= Contact [Boom - Jib 1.] connect [Boom.tadib1.] to [lib 1.to Boom]
= Contact [Eylinde - Boorn) connect [Boom.to Cylinder] to  [Cylinder.to Boom]
= Subzpzterm  [ib 1] contact+angles  [Boom)
= Contact [Slew. Ring - Bon] connect [Boom. o Slewing Ring) to [Slewing Ring.toJib
= Subspstern [Jib 2] contact+angles [lib 1]
= Contact Wb 1 -Jib 2] connect b Ttodib 2] to b 2todib1.]
= Subgystern  [Boom] contact+angles [Slewing Rina)
= Subzpztemn  [Cylinder] contact+angles  [Slewing Ring)
= Contact [Slew.R - Cylinde] connect [Slewing Ring.ta Cylinder] to  [Cylinder.to Slewing
4| m 3
zelected Entry: Fefrezh Dielete
(] Cancel Execute

“~

A “Relative Orientation” is an ordered set of orientation changes that are applied to a defined start

orientation.

“Orientation Modifications” are only modification changes without a defined start orientation.

Working positions can be represented in KRASTA by basic orientations only. In this case
modifications are applied manually and required basic orientations are created manually if achieved.
While this may be an easy approach in the first place, revision of the model may be quite time
consuming because all working positions may need individual manual updates.

In this example only one basic orientation exists. Individual movements and targets are defined as
orientation modifications as a kind of building blocks for relative orientations. In this case every target
value is only entered once in the model, which leads to a model that is easily maintained if target
changes are required.
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3.6.2 Telescoping

Telescoping requires different sets of compatible connections for the telescoping jibs. In the example
each connection consists of two nodes. Compatible connections require an equal distance between
the connection node pairs.

There is only one contact that connects the two parts. The connections used in the contact are
changed as required. Multiple contacts between two parts with contradicting connection pairs may not
be created as contradiction connection information cannot be achieved at once.

It is recommended to name connections and contacts according to their purpose.

The order of nodes within the connection definition must be in the right order. If the nodes are in the
wrong order Jib 1 will be reversed pointing backwards.

In the extended state the boom and jib 1 are connected by the nodes K15 and K23.

K 23 K1
EK T
K 23
v K 15 ¥
Z
L
3%’ Connection =] BS %" Connection = BS
Mame Subsystem Mame Subsystem
ftoJib 1. B aom |to Boom it 1
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| y a i Y 0
- B il )i z 0 —
GWOH é Gr, o é
H Normnalize T K18 Noimnalize:
2123 2K 23
Amiliarg Wector 2 Auilian Vectar 2
b .0 H 0
v 10 y 1.0
z il z 0
D o
4 M MNomalize 4 ﬂ Mormnalize
Delete Node ‘ Insert Node | Delete Node | Inzert Mode |
0K I Cancel ‘ 0F. I Cancel |
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In the retracted state the nodes K and K23 of the boom are connected to the nodes K15 and K1 of
jib 1.
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Graph. Selection | Graph. Selection |
1] [
—Di ﬂ I Momnalize | M M Mormalize |

Delete Mode Insert Mode Delete Mode | Inzert Node I
aF I Cancel I ok I Cancel |

After the required connections are created the contact can be changed manually to test the
connections. If the manual test is passed, orientation modifications are created for each jib and each
telescopic position.

-
%' Orientation (modify Position / Linking) = E3
Name IJlb'I in Comment -
 Modification
 Kinematic Modification Sequence

ILuffing 10m Contact [Boom -Jib 1. connect [Boom.taJib 1 in b Jib 1.ta Baom in]

p N
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Connection 1 |2 M 0% [Boom]toJib 1in LI
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Add » |

Up Do Delete |
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For retracting jib 1 into the boom the contact “Boom — Jib 1” and the according connections are set.

The settings have to be added to the modification sequence.

For extending jib 1 the “Orientation Modification” is created accordingly.

3.6.3 Luffing

%" Orientation (modify Position / Linking)

Name [Luffing D8m

Comment

N\

Madification Sequence

~ Kinematic:

/ | Luffing 10m

\ with Target Value

I 8000.0 mrn

S _ea | )

Add>%
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N
_N S
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Eerrection 1 [2 4 2 [Boom).io Jib 1. ~|
Eerrection 22 24/ [Jin 1]ta Boom ~|
Add> |
r Orientation Modification
JibTin ;I E dit |
Add > L L
kK I Execute I Cancel | Infarmation |

N

For the luffing a kinematic with target value 10m is already available. Within orientation modifications
and relative orientations kinematics can be “recycled” with new target values. In the example we use

the kinematic “Luffing 10m” with a target value 8m.

For each luffing target value one orientation modification is created.
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3.7 Kinematics

With “Kinematics” subsystems can be moved relative to each other, e.g. luffing of the Boom. In step
3.6 a basic orientation is created. The defined kinematics are used in “orientations” to achieve a
certain working position. “Orientations” are the geometric definition of the working position.

This example shows how to create kinematics for luffing and for slewing.

3.7.1 Luffing

As we have a triangle between slewing ring, boom and cylinder luffing is not possible without further
ado. Luffing of the real crane is done by changing the length of the cylinder. In KRASTA we need to
change the cylinder beam length as required for the working position. This is possible if cylinder nodes
at the intersection between boom and cylinder are marked as “free nodes”. If required KRASTA may
change coordinates of free nodes during subsystem movements.

o o o o o

/<|: Fix triangle

blocking luffing

In the example we have two cylinders. Both cylinder nodes (K 21 and K 22) at the intersection to the
boom are set free.

%’ Node = &
Hamne k21 In Subsystern Cylinder Information
Comment Adjoining Beams

523

Coordinate Coordinate System

% 439 mrm " Global

I 2000.0 i ' Subsystem

z 8250 o Cylinder =
[1]

Iv\ Free Node Mode Mass ,07 I Support Conditions
[1] Dizplacement Cond.
a8 = - Apply | Select other Node |
set checkmark

The free nodes need to be set at the intersection between moved subsystem and fixed subsystem. If,
other than in this example, the cylinder subsystem is child of the boom, the nodes at the intersection
between cylinder and slewing ring need to be set “free”.

|M|n|mal LI |'\."IEW H

B aum minimieren |
[ M:A13601 - KRAST A Mustermodelle und Quick startaus
B Subsystems
[El 23 Undercarriage
MHodes
Beams
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= Slewing Ring
aNocles \ Fix during luffing
Beams

Connections Moved during luffing
|27 Boom

|23 Cylinder
Contacts — Fix during luffing

[ Crnzs Sechnng
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In the kinematics dialog, select the “leading kinematic part”, which should be the topmost subsystem in
the subsystem hierarchy displayed in the subsystem branch of the object tree. Child subsystems of
the leading kinematic part are moved together with the leading subsystem.

The leading kinematic part is moved in a plane that is defined by two axes of a reference subsystem. It
is important to choose a reference subsystem in which the leading subsystem stays in the chosen
working plane. Here, the slewing ring is turned against the undercarriage, moving the boom to
different planes in the undercarriage coordinate system. The boom remains in the same plane of the
slewing ring coordinate system, even if it is turned against the undercarriage. Thus, the slewing ring
needs to be chosen as reference subsystem.

Within the reference plane various targets of the kinematic can be chosen. For the luffing of a boom
usually an angle or a working radius is chosen. In this case the boom system is moved to a jib working
radius of 10m. Two nodes have to be selected and the amount of the projected coordinate difference
between them has to be entered. The difference is measured horizontally, which is the y axis.

Contacts, in which all contact nodes are set as free nodes can be chosen as “kinematically free
contacts”. Select the according contact as free.

% Kinematic = =2
Name Luffing 10m Information Leading kinematic Pat  [goom - Graph. Selection ¢
Comment Dther kinematic Parls
Kinematic Part i ~|  Graph Selestion o
A ==
Flane and Reference System ]
CRY @2 O 2% [Slewing Ring ~|  Graph. Selection
Remove
Target
" Aingle to Axis " Angle of thiee points fiee Contacts =
£ Node Conrdinate [ndercariage] K Giraph. Selection LAy |
" Coordinate Difference Pib 21K 14 Graph. Selection Add >
& Projected Cooidinate Difference < Remove
@y Cz  Amount 100000 mm [ Best possible <Al
oK. Cancel | Apply Options | Cleat Kinematic Trace |
= —

To see the effect of the kinematic choose “Apply” within the dialog or drag the object from the object
tree and drop it on the graphics window
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3.7.2 Slewing

For Slewing the XY-plane and the Undercarriage as the reference system are selected. The slewing
ring subsystem is selected as the leading kinematic part. As Target the angle to axis is marked and
two nodes on the x-axis are selected. The X-axis is selected as the basic orientation and a starting
value of 0° is entered. For Slewing no kinematically free contacts are added.
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1 N:413601 - KRASTA Mustermadelle und QuickstartiuslegertKR
Subsystems
Contacts
Cioss Sections In}
Materials
Lists

Mass Cases
hass s % Kinematic = =
1 wind Profies o
Constraint Condiions e Sleving _Inomation_| Leading kinemalicPatt  [Slewing Ring <] Graph Selection
B KMEMWBSN Comment | - Other kinemaiic: Parts o
Kinematic: Part i =] Graph Selection mﬂxﬁﬁﬂ
- -]
Situations Plane and Rieference System Add
[ Load Events
Diamags Acoumuation @ Xt O YZ " Z¥ |Undercamiage - Graph. Selection 5
Cale_Sutes _ Romore |
Resuls Target >
1 Prasfs
1 Text Documentations & pngle o Avis € pngle of thiee points kinematicall hee Contacts
Fomats  Node Coordinate [BoamlC 11 Graph. Selection |
it fies
View " Coordinate Diference [BoomlK Graph. Selection Add>
HODHA € Frojscted Cooreinate Diference < emave
@x Oy Amount 0 . [ Bestpossitle <l
oK Cancel | Apply Optiors | Clear Kinematic Trace
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3.8 Working positions

Working positions are assembled as relative orientations with a defined start orientation and
orientation modifications containing individual subsystem movements and kinematic targets.

' ™y
% Orientation (modify Position / Linking) o) )
Narne |E+EIU L &m Comrment m
Start Orientation
IBasic Basic LI Edit |
— Modification
r Kinernatic I odification Sequence
| Luffing 10m ~| Edit Modiication  Slewing +30°
th T arget Val Modification  Jib 1 out
L SRR Modification Jib 2 out
I .0 mrm Modification  Luffing 08m
Add> |
r~ Cortact
|Boom - Jib 1. -l Edit
Eonnection 1 {2 N 2 [Boom]ta Jib 1. =l
Connection 2 ’ LI
 Orientation Modification \
ILqung 08m LI E dit )
Add > |‘

\ / Up Down Delete |
T e e infomation |

For the working position “Slewing 90°” and “Luffing 8m working radius” the orientation definition is
shown above. The “Basic” orientation is set as start orientation. The modification sequence is:

1) Slewing +90°

2) Jib 1 out

3) Jib 2 out

4) Luffing 08m

The modification list is applied one entry after the other, the order is usually important. In the example

luffing requires the right telescoping situation. Thus, the jib modifications have to be set before the
luffing modification.
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3.9 Situations

“Situations” are important objects as they define the working state of the structure for the solver.
“Situations” include an “orientation” and eventually a list of active load cases and a list of inactive
beams. “Situations” are calculated by the solver and are used in evaluation pattern for results and
proofs.

%‘ Situation (describe structural conditions) = 8
MName [5+00 L 10m Comment P Information
Orientation
Relative 5+00L 10m ~|  Edt
Active Load Cazes Inactive Beams
List | [Alle] j List | 1] j

E dit Edit

[+ Calculate Compenzation Load Cazes

ak | Cahicel | Execute

To create a situation you can create a new situation and select a relative orientation or just right click
on an Orientation in the object tree and select “Create Situation”.

Dl=l=l &l &l W Al e rlEE FF sl =k =
Mirimal =] [Viewsz RS S [N N e i T PRV RO K

B aurn minirmieren |
M aterialz ~
Listz
Mazs Cases
Load Cases
[ wind Profiles
Constraint Conditions
[E] Kinematics
Luffing 10m
Slewing
[= Orientations
Modules
B asic:
Relative

=

500 L 10m  Ficpi
5+00L43m  Re Edit...

S+00L 5.78m Re Copy...
5+00L Gm Fiek
Appl
S00L72m  Re e I
S+00L Bm Rel Delete
S+43,4 L 10m Fie S
S+49.4 L 4.3m R Create Situation

S+494L575m  Relative
5+494L6m  Relative E]/
S+494L 7 2m Relative

S+43.4 L 8m Relative
S+30L 10m Relative

KUHNE BSB GmbH Férdertechnik & Stahlbau 08.08.14



KRASTA Telescopic Crane System, version 1

For mass creation of situations use the following menu item:
Calculation > (Situation) > Create for Orientations...

Page 18 of 22

To visually check the situation you can switch through the situations with the top right selection box.
Once this selection box has focused you may use the arrow up and down keys to move within the

selection.

E| o I S P

L] [5 =] wxr|av]az] 2y [0

ing Riing -
HalaEle arE

S+00 L 5,75m
S+00 L Bm
S+00L72m
5+00 L 8m
S+43.41 10m
S+43.41 4.3m
S+43.4 L 575m
S5+43.4 L Bm
S+43.4L7.2m
S+49,4L 8m
S+30 L 10m
S+30L43m
S+30 L 5,75m
S+90 L 6m
S+80L72m
5480 L 8m
5-484110m
5-43.41 4.3m
5-43.4 L 5.75m

3.9.1 Situation lists

Situations can be grouped by situation lists to use them for situation dependent mass cases,

calculation suites or result evaluation.

In the example there are situation lists for
- situations with similar payload

- in service situations

- out of service situations
- situations to be calculated by the solver
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3.9.2 Situation depended Mass Case

The payload mass should vary depending on the jib working radius. Therefor a situation depended
mass case is created. A situation dependent mass case forks to different mass cases and factors
depending on the situation that is evaluated.

A default mass case needs to be set. In this example a mass of 100.000 kg is used to notice
immediately if the evaluated situation is not explicitly handled by this mass case.

A situation or a situation list is to be selected and added in combination with factor and a mass case. A
situation or situation list can only be used once. A situation may be used implicitly multiple times via
situation lists. In this case the definition is used that is first in the order of entries. A Mass case can be
referred multiple times.

In this example the following payload masses are applied:

Working Radius Mass
[m] [kel
10,00 350
8,00 450
6,00 625
7,20 550
5,75 700
4,30 1000
%’ Situation depended Mass Case X
Mame  [Payload Cormment m

Default b azs Caze

If evaluated situation is not explicitly handled by this Mass Caze, then. ..

" show warning (" is Mass zero f* uze following Mazs: 1000 - |F'E|1 tazz 100kg EMC j

Situation relations

Factor 1.0 o 1eassign

Situation You can group situations by lists to use them here.
|Ealculation Situation List j Per situation at mast one definition can be made.
Mass Case A Mazs Case can be referred multiple times
$Pemanent M L 1dm} = 35* PO Mass 100kg BMC
DL tokal CMC iL_Bm} = 45% PO Mazz 100kg BMC
DL+Payload ChC iL_Bm} =3 B.25* PO Maszs 100kg BRLC
k01 Kick Cylinde BMC iL_7.2m} = 55+ PO Mazs 100kg BMC
F02 Slewing Ring BRC =3
POT Mass 100kg BMC _Add> | i 43m; = 01 b _Up |
S0 Support BMC
502 Undercariag BMC Down
503 Pilar BMC __<Remove_|
505 Boom BMC
<

Sorted by Alphabet > expand Sorted by |[] j

] | Cancel | Infiarmation
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3.10 Solving the model

“Calculation suites” manage the solvers. In calculation suites you can select the situations to solve, the
solver and the theory. In the example the calculation suite “PAS linear” is prepared to solve all
situations with solver “PAS IV” with linear theory.

To solve the model expand the “Calculation suite” branch in the object tree, click with the right mouse
button on “PAS Linear” and choose “Apply”.

% Calculation Suite = =
Narne PAS Linear Comment P Informatin
Options Solver
¥ Calculate immediately ™ Clear results before r f‘:eahl célciog b‘efore Pag I £ inear C The
erbosity Level [
PAS IV * linear " Th.2
Situations
Available Calculate bn € modal analysis
[ 43m  Siustion List Al> Sab88 (" linear " nonlinear
L_5.75m  Situation List E|
L_Em Situation List T Nodya " Slabiliy
L_7.2m  Situation List Add »
L 8m Situation List
S+00 Situation List
54434 Siustion List _chamove |
S+90, Situation List
S-494.  Situation List <Al
5-50 Situation List 4
Edit Up Down
ok | Evecute Cancel |
|Executable

After the solver run is done please check the calculation log for warnings and errors. You can find the
calculation log in the main menu: “Calculation” > “Show log file...”
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3.11 Result evaluation

3.11.1 Results for basic and combination load cases

Results for basic and combination load cases can be switched on in the “display setting” dialog. The
following results are available.

For beams: Inner forces, beam deformations, bending line
For nodes: support forces

Logic load cases are not available in this dialog, as they usually expand to more than one load
permutation.

3 KRASTA 9.7.08.4690 - N:\13601 - KRASTA und Q T, k2 *

File Edit View Selection Construction Propety List Subsystem Load Mass CrossSection Material Calculation Result Proof Option Modal Analysis Nodya ?

Dl 8 ] & | ma 2 [cpine | [s+o0L10m =]
Winma | ") Display settings » = 2N EQmR® ] =] X ewsyempee] <]

Bau Beam | Node | Goord /Subs. | LosdiMess  Load Case Result | Extr. Results | Eigenveat |
I NATI60T - KRASTA My
Subsystems
Cortacts

I™ Inner Forces Wiew Factor [ 1.0
Cross Sections
Materials nomal force -

Lists _—
Mass Cases o Figues %
Load Cases

[ Wind Frofies I Beam Defomations ViewFactor | 10 -

Corstrairt Condiions [reamdipboements =]

Kinematics
Orientations [rofgwes =]
Siuatons

[ Losd Events

Damage Accumlation [ BendingLine Magrification Factor [ 500
Beams: |[al] =l
1 Proofs
ar W Support Forces ViewFactor [ 10
Formats [Figures atal | T scalelogaithical 179
Piint les Components: 1282
[ View v
W o
DDA, My o
Mz ¥z Hodes: |[al] hd
Load Event
Situation [[Crent Situation] ~
Load Case [DLuPayload OLC =] Content
Plat figures {in default format <
™ consider constiaint conditions 2043
™ Hidden Lines
oK ‘ Carcel Apply
[node display with node boxes:
bean display with beam axis;
constraint conditions are not considered;
support forces, load case: DL+Payload situation: $+00 L 16m
total of all forces : 8, 0, M1.20179 [KN]
total of all moments H ., ., -0 [khem]
reference point : 0, 0, .0 [cm]
resulting moments : -.0434, -6079.6431, 6.1035E-06 [kNcm]
point of balanced overturning moments
at x-y plane: 147.56, -1.0536E-03, .8 [cm]
‘ v
Done: Execute Situation [3+00 L 10rm] [mode = 0] -
Done: Ex modk

em kN ko sec'C-
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3.11.2 Result controls

Result controls and proofs are available in the object tree. Some have already been prepared in the
example model. Edit one to open the dialog.

[ Load Events
Damage Accumulation
Calc_Suitez
= Results
.pattern
Rope load
Stieed
Sup Edit...
5up Copy..
Tury
Tu Apply
= P Delete
1504 -
[ Test Documentations
Farmats
Wigw

On the left side of the dialog you can switch on the search for extreme values and select a list of
beams/nodes for which the results should be evaluated. On the right side you can control the output.
Output is possible as text results, border line or color contour.

In the lower part you define the evaluation pattern. The selected situations/loads are displayed on the
right side. Other results controls can be selected as a prototype.

[ TP T T Lanctrict Lict Loar  Riace I rocc sactuoe L aleuiat) Hacut  Uenpt

J Y Oul&jt of S_tresses . a A N - - e = —
l Hame Sigma¥ tmp Camment - Information E
= Output
Details
[v Stouct. Elem.
B WS M Tet T TAB delinited
|Spannungen kurz j Edit
Options for search of extreme values I~ Border Line .
v Extreme values of i i
|cnmhlned stress [v. Mises) j |Edge o Erome Values j
Type of Extremurn |mammum j “iew Factar [
Output of |extreme value per beam j
Bocliten [¥ Calour Cantour
For following Beams - [ga)_Beams [sirmple] | Edt | [47 of 256_ | Edit
E valuation for |a|\ sections j Adaption
Filter will nat be used Edit
Eval. Pattern
as |delined here j I Evaluate each line separately
r
Situation |05 Situation List j {i5} DL+Paylbad CLC =» 30 LE
{aS) DL total BLC
DL+Fapload  CLC _ bdd> |
DL tatal BLC
Payload ELC
< Remove
Contents => 31 Load Events
Ok | Save and Evecute I Cancel | Up Diown
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